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INTRODUCTION
These guidelines have been prepared to help graduate students prepare their theses for acceptance by Riga
Technical University (RTU) in program “Environmental Science”. All theses must be prepared according
to format requirements described in this guide. The Thesis format guidelines ensure that Thesis are uniformly presented and appropriately formatted for the defense and graduation of the program. Thereof, students should carefully review this guide. The format requirements dictate such matters as: typeface and
quality, spacing, margins, page numbering, placement of notes, headings, formatting of tables, figures, title
page, citing and referencing, etc.
Any questions about the contents of the guidelines should be directed to the format representatives of
RTU. The format advisors are concerned solely with the format of the Thesis. It is the advisors’ responsibility to make certain that Thesis submitted for defense of master’s degree in the RTU conforms to the regulations outlined in this guide. Responsibility for the content of any Thesis remains with the student, his
supervisor(s) and the program advisor(s).
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1. PURPOSE AND INTENDED LEARNING OUTCOMES OF A
THESIS
The thesis is a carefully argued scholarly paper. It should present an original argument that is carefully documented from primary and/or secondary sources. The Thesis must have a substantial research component
and a focus that falls within science, and it must be written under the guidance of a supervisor. As the final
element in the degree, the Thesis gives the student an opportunity to demonstrate expertise in the chosen
research area.
The purpose of a Thesis is to enable the student to develop deeper knowledge, understanding, capabilities
and attitudes in the context of the specific study program. The thesis should be written at the end of the
program and offers the opportunity to delve more deeply into and synthesize knowledge acquired in previous studies. A Thesis for a Bachelor and Master of Science programs should place emphasis on the technical and scientific aspects of the subject matter. The overall goal of the Thesis is for the student to display
the knowledge and capability required for independent work as a Bachelor and Master of Science. Specific
learning outcomes for a thesis are for the student to demonstrate:


Considerably more in-depth knowledge of the major subject/field of study, including deeper insight into
current research and development work,



Deeper knowledge of methods in the major subject/field of study,



A capability to contribute to research and development work,



The capability to use a holistic view to critically, independently and creatively identify, formulate and
deal with complex issues,



The capability to plan and use adequate methods to conduct qualified tasks in given frameworks and to
evaluate this work,



The capability to create, analyze and critically evaluate different technical/architectural solutions,



The capability to critically and systematically integrate knowledge,



The capability to clearly present and discuss the conclusions as well as the knowledge and arguments
that form the basis for these findings in written and spoken English,



The capability to identify the issues that must be addressed within the framework of the specific thesis
in order to take into consideration all relevant dimensions of sustainable development,



A consciousness of the ethical aspects of research and development work.

Final mark algorithm
Final mark for the thesis is being generated through algorithm of several points that a student gets during
his/her study. The algorithm is as follows:
V  0.6  vid

V

i

 0.25  Ar  0.15  Vs

where
V – mark for the final work, points;
Vi – individual evaluation of the thesis by committee members, points;
Vr – reviewer’s evaluation of the thesis, points;
Vs – process during the semester, points (student has to hand over his/her work to the quality control regularly during the semester).
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2. GENERAL PROVISIONS
1. The layout of the Thesis has to comply with the general formatting regulations set for scientific manuscripts and project documentation.
2. The Thesis must consist of approximately 80 pages for Master’s Thesis and app. 60 pages for Bachelor’s (excluding appendices and list of references). In addition, the total size of the Thesis must be chosen so as to completely cover the specific topic and reach the aim of the Thesis.
3. The recommended structure of the Thesis is as follows:
a. Introductory part 3-5%
b. Main research part (including literature review, methodology, results) 92-95%
c. Conclusions and recommendations 2-3%
4. Requirements for content of work organization:
1. Title page (see App. 1)
2. Signature Page (see App. 2)
3. Declaration of authorship (see App. 3).
4. Confirmation of the Thesis’ submission to the ORTUS system (see point 83)
5. Supervisors’ task
7. Annotation in two languages (English, Latvian)
8. Table of contents
9. List of figures
10.List of tables
11.Abbreviations
12.Introduction
13.Literature review*
14.Methodology
15.Results and discussion
16.Conclusion and recomendations
17.References
18.List of author’s publications**
19.List of author’s presentations***
20.Appendices
5. The title page, signature page, declaration of authorship and supervisors’ task page are formatted in
compliance with the templates provided in the appendix.
6. The Introduction should be subdivided into following sections: Problem, Actuality of the study, Aim of
the study, Objectives, Object, Novelty, Practical significance, Hypothesis.
7. Conclusions should be provided after each main chapter, where the main ideas, results and conclusions
are summarized.
8. The sections of Methodology, as well as Results and discussion should include detailed description of
all the research methods used (e.g. theoretical, experimental, modelling) in the thesis.

*The number of chapters and their titles may vary. The examples given here (Literature review, Methodology, Results and discussion) are
common, but individual Theses may have different numbers of chapters and/or different titles.
**Copies of the publications should be provided in the Appendices section
***Certificates of the attended conferences, seminars and other events should be provided in the Appendices section
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3. GENERAL PROVISIONS
3.1. Body Text
9. The text should be written using Times New Roman style, font style – Regular, single space between the
lines and font size 12pt. The alignment of the text should be justified.
1

2

10.The following margins are imposed: top and inside margin – 3 cm; bottom
and outside margin – 2 cm; header and footer – 1,3 cm. Header and footer are
left blank. The inside and outside margins are defined as the Thesis must be
printed two-sided (on both sides of a page – starting from the Table of contents). Thereof, “Mirror margins” have to be defined (can be done in MS
Word tab “Page Layout” → “Pages Setup” → “Margins” → choose “Mirror
margins” at Multiple pages and “Apply to Whole document”). All Thesis materials must fit within these margin requirements (including tables, figures,
graphs and page numbers). When full-page prints of photographs are desired,
the image area of the print must conform to the same margins as the text
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Picture 1. Example: Setting
of margins

11.A new paragraph is indicated by indenting the first line
with 1 cm. No spaces between the paragraphs are required.

Picture 2. Example: Setting the right margins
12.All pages must be numbered with Arabic numerals placed in
the bottom outer edge of the page (choose Different Odd & Even
Pages). It is not recommended to use any lines, points or other
signs before and after the number. There are no page numbers
written on the first pages (up to the literature review), but they are
considered in the total number of pages. Thus, page numbers are
placed on pages starting with the Literature review section.

1

2

4
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Picture 3. Example: Setting – Page Setup tool
13.Reference notes may NOT be placed at the bottom of the page, at the end of the chapter , or at the
end of the Thesis before the reference list.

3.2. Headings
14.Each chapter of the Thesis starts on a new page. Sub-chapters are continued on a started page. Titles and
headings should clearly stand from the previous text by 12 pt and from the following text by 6 pt.
15.Chapter titles are written in capital letters, Times New Roman style, font style – Bold, and font size
14pt. Sub-chapter headings are written with the first capital letter only following with small letters,
Times New Roman style, font style – Bold, and font size 13pt. Titles and headings are placed in the center of the page with no indention from the left side.
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16.Syllabification, letter underlining and full stops are not applied in the titles and headings.

17.The main parts of the Thesis are numbered in
sequence, and the numbers are placed before the
title. The chapters are numbered applying Arabic
numerals, e.g., 1., 2., etc. The sub-chapters are
numbered in sequence with the chapter number
applying two Arabic numerals, e.g., the numbers
for the sub-chapters within the first chapter shall
be 1.1., 1.2., etc. If the sub-chapter comprises
multiple sections, then they are numbered within
the particular sub-chapter applying three Arabic
numerals, e.g., 2.2.1., 2.2.2., etc. For indicating
sub-sections Arabic numerals or small letters
with a round bracket are used, e.g., 1), 2) or a),
b), etc. The text after the number is written with
the first capital letter. Only the main research
chapters, i.e. Literature review, Methodology,
Results and discussion, are numbered. The rest
are left with no numbering.

Picture 4. Example (text, heading, spacing, etc.)

3.3. Body Text
18.Figures and tables are most effective when they are clear, self-explanatory, accurate, easily understood
and remembered. In general, tables and figures should have enough explanation in their captions (titles)
to stand alone.
19.Tables and figures (graphs, charts, drawing, and photographs) must be embedded in the document. They
should be placed between paragraphs, after (or near) their first mention in the text.
20.Figure captions have to be placed below the figures and not in “text boxes” linked to the figures. Table
titles have to be placed above the tables.
21.A minimum of one sentence summarizing what the figure/table shows or illustrates should be included
in the text. Also it should be verified that the figures and tables mentioned in the text actually exist.
22.The figures are placed centered with no indentations. The figures are numbered within the corresponding chapter (e.g. Figure 1.3. denoting the third figure in the first chapter). Each figure should be given a
title (caption). If the Thesis contains only one figure, it is not numbered, but it is given a title. The number and caption of the figure are placed centered symmetrically below the illustration.
23.The word “Fig.” should be followed by one space, an Arabic numeral, a period, one blank space, the
caption with only the first word and proper nouns capitalized, and no period at the end. The style used
for figure captions is Times New Roman, font style – Regular, and font size 12pt.

24.The space before and after the figure, its caption and text is 12pt.
For example, the first figure in the third chapter should be formatted in the following way:

Fig. 1.3. The title of the figure
25.If some explanatory notes are required for the figure, they can be placed below the title. Explanatory
notes should be given in a smaller size letters, i.e. 10pt.
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26.A reference to a figure should be given in the text and typed as Fig. 1 or Figs 2 to 4, with “Fig.” capitalized and abbreviated (unless it is the first word in a sentence) and without period at the end (unless
the reference appears at the end of a sentence). E.g.
Example:
…the process is illustrated in the scheme provided in Fig.1.3.
Figure 1.3 shows…”, or “…(see Figs.1.3 and 2.4).
27.The recommended font in a figure is Times New Roman, same size as the text. Figure lettering should
be large enough to be readily legible when the drawing is reduced. Axes titles on graphs must be labeled
with words rather than symbols. As an example, an axe should be labeled as the quantity “Pressure” not
just “p”. Units should be put in parentheses.

28.If a figure has two (or more) parts, authors should include the labels “(a)”,“(b)”… as part of the figure.
29.If scanned figures are provided, they have to be clear, with all the legends and data la-bels easily readable. If this is not possible, the author must redraw the figures especially in the case of simple one. Illustrations borrowed or adapted from another source have to be properly cited.
30.The tables provided in the Thesis should be numbered and they should have captions. The tables are
placed centered with no indentations.
31.The caption of a table is placed right-sided above the table with no indentations. The word Table should
be followed by one space, an Arabic numeral, a period, one space, and caption, with only the first word
and proper nouns capitalized. Tables are numbered within the corresponding chapter with Arabic numerals (e.g. Table 1.3. denoting the third table in the first chapter). If the Thesis contains only one table,
it is not numbered, but it is given a title. The space before and after the table caption should be 12pt and
6pt, respectively.
32.Tables should be as simple as possible. The text in the table should be written using Times New Roman
style, single space between the lines and font size 12pt (the size of the fonts can be decreased till the
readable values (not less than 9pt). Tables should have single horizontal lines (½ pt) above and below
column headings and subheadings, and at the bottom of the table (if it is necessary the authors may put
the horizontal lines between the rows). Limit the number of columns to fewer than 10, since the use of
many columns will create readability problems. Vertical lines and shaded areas should be avoided where
possible. Fancy frames or borders around tables should not be used.
33.All tables should be prepared using Word’s table-making features. Tables should be fitted in the page,
by using AutoFit option: first “AutoFit-to-Contents” and then “AutoFit-to-Window”. Any of the other
options under the Table menu such as: Insert, Delete, Merge cells, Distribute columns evenly, Align text
etc., to adjust the cells can be used.

For example, the first table in the third chapter should be formatted in the following way:
Example of table formatting (spacing, letter size, etc.)
Table 3.1. Title of the Table
Month
JAN
FEB
MAR
APR
MAY

ρcs, %
5.88
6.79
5.48
16.39
11.18

ρps, %
36.88
45.65
40.40
51.58
45.27

ρos, %
57.24
47.57
54.12
32.03
43.55

JUN
JUL

12.87
15.94

33.68
40.45

53.45
43.62
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34.A table should have one extra line spacing after it, followed by other text or objects.

35.A reference to the table should be given in the text and typed as Table 1 or Tables 2 to 4. Authors
should not abbreviate “Table” and should not put period after number, unless the reference appears at
the end of a sentence. E.g.:

Example:

…as it can be concluded from the data provided in Table 3.1., …
Table 3.1 shows data from….”, or “... (see Table 3.1).

3.4. Equations
36.The mathematical formulas and equations included in the Thesis are placed in the text, however, each
formula is written on a separate line. The symbols used in equations have to be explained below the formula. The formulas are numbered with Arabic numerals, which are placed in the brackets on the right of
the formula, within the corresponding chapter. If there is only one formula in the Thesis, it is not numbered.
For example, the first equation in the second chapter should be formatted in the following way:

Example:
m

V M
V0

(2.1)

where
m – mass, g
V – volume, l
M – molecular weight, g/mol
Vo – molar volume of an ideal gas at standard temperature and pressure, l/mol.
37.If the formula comprises multiple lines, then the number of the formula is given in the brackets on the
right of the last line of the formula.
38.When a reference to a formula is provided in the text, its number is provided in the same way – in the
round brackets. Equations should be referred in the text by “Eq. (2.1)” or “Equation (2.1)” if it is in the
beginning of a sentence. e.g.:
Example:
Equation (2.1) is used....,
.... (Eq.(2.1)).
39.A recommended order of closures for parenthesis, brackets and braces, is the following:

  .....  
40.Expressions which are simple, short, and not of major importance can be left in the text, and written in
one-line form (e.g., use β = a/b for fractions). For expressions within a line of text, regular text and the
symbols from Symbol dialog box should be used.

3.5. Appendices
41.Some auxiliary materials, which cannot be placed into the main body of the Thesis, are provided in the
appendices, under the umbrella title – APPENDICES, placed on a separate page (formatted as a chapter
heading without any numbering).
8

42.Each appendix should start on a separate page. In the top right corner of the page the sequence number
of the appendix is provided, e.g., A ppendix 1, Appendix 2, etc. In the center of the next line the title of
the appendix is given. If there is only one appendix in the Thesis, the umbrella title is not required, and
the appendix is not numbered. The reference to an appendix should be given in the text, e.g.:

Example:
…the data is provided in the Appendix 1.,
…(see App.1).
43.The page with the umbrella title “Appendices” is numbered and shown in the Table of contents. Also
other pages of appendices are numbered, but are not included in the Table of contents.
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4. CITING AND REFERENCING
44.It is vital that the sources of information that have been used for the Thesis are acknowledged. This will
help you protect yourself against charges of plagiarism and also demonstrate that you understand the
importance of professional research work.
45.The sources must be acknowledged whenever another person's ideas or points are paraphrased or summarized, or when another person's work is quoted. Also when tables, graphs, figures, etc. are used that
have been found from another source, be it from a printed document or from the web, must be acknowledged.
46.There are two steps to acknowledging the used sources:


cite your references in the text, to show where you have drawn upon other people's work,



list the references at the end of your Thesis under the heading 'References'.

Two citing methods may be used – Harvard and ISO 690 (Numerical Reference). In Harvard style you
place authors surname and year of the publication at the end of the citation. In ISO 690 instead of the
surname and year you shall place [number] of the reference, starting with the [1] and going in the rising
order.

4.1. Citing your sources in the text using Harvard style
47.When you refer to another’s words or ideas in your coursework, you must cite your source. At an appropriate point in your text, provide the author’s surname and the year of publication in round brackets. If
you include the author’s name in your sentence, only provide the year of publication in brackets, e.g.:
It has been argued (Harris, 2001) that the main considerations are…
It has been argued by Harris (2001) that the main considerations are…

48.For edited books that contain collections of chapters written by different authors, cite the author of the
chapter and not the editor of the overall book.
49.If you are citing different publications written by the same author in the same year, label the first one
cited with the letter ‘a’ after the year and the second ‘b’ etc. e.g. (Smith, 2004a), (Smith, 2004b). You
will need to do the same in your list of references.
50.Where two authors have produced the work, include both their last names in your citation e.g.
(Cullingworth and Nadin, 2007) or Cullingworth and Nadin (2007).
51.When there are three or more authors use the abbreviation “et al.” (and others) after the first author’s
surname e.g. Tayler et al. (2003) or (Tayler et al., 2003).
52.If you are discussing a point about which several authors have expressed similar views, include them all
in one set of brackets in chronological order of publication. List any works published in the same year in
alphabetical order e.g. (Midgley, 1994; Smith, 2004; UNCHS, 2006; Gandelsonas, 2012).
53.Where possible you should aim to reference from the original source. However, sometimes you may
need to cite an author whose work you have not personally read, but whose work is presented or summarized by the author of a publication you have consulted. This can be shown as follows:

Example:
Rondinelli (1993), cited in Potts (2012, p. 37), describes the stages of a project…
or
A process project might consist of a number of stages including experimentation and production
(Rondinelli, 1993, cited in Potts 2012, p. 37).
In your references you should list the source you have actually read, i.e. Potts.
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4.2. Directly quoting from your sources
54.You should aim to paraphrase information provided by an author in your own words rather than quote
large amounts of their work verbatim as this helps to demonstrate to the reader your understanding of
the information. It can be necessary to quote directly from the text when you:


Cannot present the information more succinctly or in any other way.



Need to present a particular portion of an author’s text in your work to analyze it.

55.If the quotation is short, enclose the writer’s words in double quotation marks and then cite the author,
date and page number, e.g.:

Example:
Key causes of economic deprivation include low income or unemployment which are often the
result of “poor qualification levels and lack of basic skills” (Thake and Saubach 1993, p. 18).
56.Longer quotations should be separated from the body of your text and indented from the left-hand margin. When you indent a quotation, there is no need to include quotation marks, e.g.

Example:
As Joia and Sanz (2005, p. 5) observe:
In specific terms, it might be imagined that the benefits of web consumer retention would only
seem to be advantageous for digital companies that are client-centric, which can interact with
these consumers. Furthermore, the mere fact of using transactional practices, low differentiation
between products and the emphasis on promotion of price on the web would seem to increase
sensitivity to price.
In the current fiercely competitive internet commerce climate it would seem that these observations might well be borne out.
57.If you omit some words from the quotation, you need to indicate this by typing in three dots, e.g. “The
state has an essential role … in the legal definition of property rights” (Deininger 2003, p. 69)
58.If you add some of your own words within the quotation, place your words in [square brackets] to make
it clear which are the author’s words and which are yours. Remember to quote exactly as the words appear in the original: do not add bold or italics.

4.3. Referencing
59.Referencing means giving a full description of each source you have cited in the text, in a list of references or bibliography, at the end of your coursework (under the heading REFERENCES).
60.Write the list in alphabetical order: put the first author’s last name first and then his/her initials.
61.Include the names and initials of all authors. Arrange any references with the same author by the year of
publication, beginning with the oldest.
62.Titles should be italicized for books, reports and conference proceedings. For journal articles, the title of
the journal (not the title of the journal article) should be printed in italics.
63.Capitalize the first letter of each author’s last name and each initial. Also capitalize the first letter of the
publication title written in italics, the first letters of all main words in the title of a journal and all first
letters of a place name and publisher.

64.The references should be written using Times New Roman style, font size 12pt. Single space between
the lines should be used. The space before and after each reference should be 6pt. The alignment of the
text should be justified. Each new reference has indentation hanging by 1.5 cm.
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Example: reference formatting
Cooke, D.J. and Philip, L. 2001. To treat or not to treat? An empirical perspective. In: Hollin, C.R. ed. Handbook of offender assessment and treatment. Chichester: Wiley,
pp. 3-15.
Potts, D. 2002. Project planning and analysis for development. Boulder, Colorado: Lynne
Reinner.
Redknap, M. et al. eds. 2001. Fourth International Conference on Insular Art. National Museum & Gallery, Cardiff, 3-6 September 1998. Oxford: Oxbow.

4.4. The general provisions for organizing references
65.Book
You need to include the following information:
Author. Year. Book title. Place: Publisher.

Example:
Potts, D. 2002. Project planning and analysis for development. Boulder, Colorado: Lynne
Reinner.
If there are three or more authors include all their names or just write the first author's name and then
write et al. If the book is in its second edition or beyond, you also need to include this information in
the reference:

Example:
Seifert, K. L. et al. 2000. Lifespan development. 2nd ed. Boston: Houghton Mifflin.
Seifert, K. L., Hoffnung, R.J. and Hoffnung, M. 2000. Lifespan development. 2nd ed. Boston: Houghton Mifflin.
66.Book chapter
Edited books contain collections of chapters which are written by different authors and collated by an
editor or editors. To reference a chapter in an edited book you need to record the following details:

Chapter Author(s). Year. Title of chapter. In: Book Editor ed/eds. Book title. Place: Publisher,
chapter page numbers.

Example:
Cooke, D.J. and Philip, L. 2001. To treat or not to treat? An empirical perspective. In: Hollin, C.R. ed. Handbook of offender assessment and treatment. Chichester: Wiley, pp. 3-15.
67.Journal articles
You can reference both print articles and their electronic equivalents. To cite a journal article you will
need to record the following information:
Author. Year. Article title. Journal Title volume(issue), pages.

Example:
Waterson, M. 2003. The role of consumers in competition and competition policy. International Journal of Industrial Organization 21(2), pp. 129-50.
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68.Conference paper

If you are citing an individual paper within the conference proceedings, the author of the paper should
be the first element of the reference. The page numbers of the paper, within the proceedings as a whole,
should be included.

Example:
Fledelius, H.C. 2000. Myopia and significant visual impairment: global aspects. In: Lin,
L.L.-K. et al. eds. Myopia Updates II: Proceedings of the 7th International Conference on
Myopia. Taipei, 17-20 November, 1998. Tokyo: Springer, pp. 31-37.
The first element of a reference to a conference proceeding should be the person or organization responsible for editing the proceedings. The place and date of the conference should also be included.

Example:
Redknap, M. et al. eds. 2001. Fourth International Conference on Insular A rt. National Museum & Gallery, Cardiff, 3-6 September 1998. Oxford: Oxbow.
If no editor is traceable, substitute this with the name of the conference.

Example:
Building on the evidence: proceedings of the second conference on evidence-based Practice. 1999. 16-17 April 1999. Norwich: Norfolk Healthcare Trust.

This should be cited within your text (the main body of your coursework) as (Building on the evidence,
1999).
69.Report
If there is no individual author, use the name of the organization.

Example:
European Commission. 2004. First report on the implementation of the internal market
strategy 2003-2006. Luxembourg: Office for Official Publications of the European Communities.

70.Thesis
Be sure to indicate the level (e.g. MA, MSc, or PhD) of the Thesis and the institution at which it was
presented.

Example:
Boyce, P. J. 2003. GammaFinder: a Java application to find galaxies in astronomical spectral line datacubes. MSc Dissertation, Cardiff University.
Bin Omar, A. 1978. Peasants, institutions and development in Malaysia: the political economy of development in the Muda region. PhD Thesis, Cornell University.
71.Newspaper article
The format required is similar to that of an academic journal article, except that there will be a precise
day of publication, and volume numbers are not usually available or necessary. Also online versions can
be referenced like this.
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Example:
Benoit, B. 2007. G8 faces impasse on global warming. Financial Times 29 May 2007, p.9.
72.Electronic journal article
If the electronic journal article is also available in paper format and if the layout, page numbers, text
and images are exactly the same, you can just reference it as you would a print journal article.
For a journal article which is only available online or differs from its print version you will need to include the date when you found it and the URL:
Author(s). Year. Article title. Journal Title [Online] volume. Available at: URL [Accessed: day Month
year].

Example:
Merchent, A.T. 2007. Diet, physical activity, and adiposity in children in poor and rich
neighbourhoods: a cross-sectional comparison. Nutrition Journal [Online] 6. Available at:
http://www.nutritionj.com/content/pdf/1475-2891-6-1.pdf [Accessed: 27 February 2007].
73. Internet sources
Referencing a web source can be difficult. If no author is given, web pages can be referenced by the organization responsible or by the title instead. A good web site should, however, have sufficient ownership information to enable you to cite it. If no ownership is detectable, you should question whether the
source is of sufficient quality. Ideally you should aim to include the following information:
Author (if available) or Organization. Publication Date. Document title [online]. Place: Publisher (if available). Available at: web address of document [Accessed: date you viewed the site].
For an Internet-based work by an individual the reference should be given as follows:
Author or Editor (if available). Year (if available). Title [Online]. Place: Publisher (if available). Available at: web address of document [Accessed: day Month year]

Example:
Lane, C. et al. 2003. The future of professionalized work: UK and Germany compared
[Online]. London: Anglo-German Foundation for the Study of Industrial Society. Available
at: http://www.agf.org.uk/pubs/pdfs/1232web.pdf [Accessed: 10 May 2007].

The publisher and place of publication can be thought of as the organization responsible for hosting the
site, although can be left out if unavailable.
As well as the complete URL to the page, always give the date at which you accessed it. Web sites appear and disappear so often that it is vital to indicate that the information was accurate at the date given.
Wikipedia: There is usually no discernable author of a wiki entry and so this information can be excluded from the reference if unavailable. Instead, begin your reference with the title of the wiki article,
then provide the year the page was last updated followed by the title of the web site.

Example:
A map of our own: Kwun Tong culture and histories. 2009. Creative commons wiki
[Online]. Available at:
http://wiki.creativecommons.org/Case_Studies/
A_Map_of_Our_Own:Kwun_Tong_Culture_and_Histories [Accessed: 18 June 2010].
Please note that as it is often difficult to tell who has authored a wiki post, it is essential that you verify
the accuracy of the information provided using scholarly sources such as books or journal articles.
Check with your lecturer or tutor before referencing sources such as Wikipedia.
14

YouTube video:

Example:
Libncsu. 2009. W ikipedia: beneath the surface [Online]. Available at: http://
www.youtube.com/watch?v=QY8otRh1QPc [Accessed: 21 June 2010].
74.Personal communication

Example:
Smith,
K.
2004.
Email
to
B.
Robertson
Young, Z. 2007. Letter to S. Nicholas 28 September 2007.
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April

2004.

When referencing a message on a discussion board in the virtual learning environment, include the following details:
Author. Year. Title of message. Title of discussion board. In: Name of academic module
[Online] Day Month Year of post. Available at: URL of virtual learning environment
[Accessed: Day Month Year].

Example:
Smith, A. 2010. Quality of Wikipedia articles. W ikipedia debate discussion board. In:
Study Skills [Online] 12 June 2010. Available at: http://cue.cf.ac.uk [Accessed: 18 June
2010].

When discussion lists are referenced, use the following example:

Example:
Little, L. 2002. Two new policy briefs. ECPOLICY discussion list [Online] 16 April 2002.
Available
at:
http://www.askeric.org/VirtualListserv_Archives/ECPOLICY/2002/Apr_2002/
Msg00003.html [Accessed: 8 November 2003].
For all email references, the title of the message comes from the email subject line.

4.5. References by Mendeley
Mendeley is a free tool that lets you manage your library with the following features:


Add PDF files to your library.



Import / export files from other bibliographic management tools such as EndNote, BibTex and RIS.



Find documents online by document ID (eg DOI) or by name and add them to your library.



Import one-click links from a web site such as EBSCO or SpringerLink etc.;



Manage your documents and bibliographic references;



Add bibliographic references after the selected citation in MS W ord and Open Office standard documents and automatically create a list of bibliographic references (references);



Share documents on the Mendeley social network
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Users registration
In order to use Mendeley you must register at www.mendeley.com. When registering, it is recommended
that you use the email provided by RTU to take full advantage of the university in the future. The Mendeley tool has several user interfaces:


Mendey Web – a social network for collaboration and communication with other researchers, sharing
documents, building a library for your research team;



Mendeley Desktop – an app that needs to be installed on your computer. The Mendeley Desktop app
gives you control over your library and references. Synchronization between the Mendeley Web and
the local application is ensured;



Mendeley Mobile – mobile apps with limited functionality, compared to Mendeley Desktop, are more
for reading, searching, and less for document processing.

Creating the library
The Mendeley tool enables you to create a source library with and without full text. This tool can be used
both as a collection of read books and as a list of unread books. It allows you to easily group sources, supplement source descriptions, automatically insert
source descriptions from PDFs and web resources.
The PDF file format is the most common source format, which is why the Mendeley tool provides a number of options for working with it. You can add PDFs
to your library by clicking the Add Files button or by
using the Drag & Drop function to place the file in the
All Documents list.

Picture 5. Adding PDF file in Mendeley
Mendeley will automatically attempt to determine the bibliographic data of the
attached PDF document - title, year of publication, pages.
If all bibliographic data is complete and correct, you can press the Details are
Correct button. Alternatively, you can press Search, and Mendeley will try to
find information about this document online and complete it. The user may also
fill in the missing information himself if Mendeley fails to complete the bibliographic data. It is recommended that you fill in the DOI field if the document is
assigned a DOI. With DOI, Mendeley can retrieve missing data. It is recommended that you fill in as much bibliographic information as possible, as this
will be useful in automatically creating references and a list of references. Mendeley provides the ability to import / export documents from other bibliographic reference tools such as EndNote, BibTex and RIS.
Picture 6. Automatic identification of the bibliographical data in Mendeley
Another way you can add documents to your library is to enter a document ID such as DOI and have Mendeley find the document online. You must select File / Add Entry Manually and enter
a DOI. You need to press a button similar to a magnifying glass
and Mendeley will find the document. You need to press the Save
button and the document will be saved to the Mendeley library.

1
2

Picture 7. Adding a source by DOI
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3

File /Add Entry Manually can be used to enter descriptions of other
sources. After calling the tool, you must select the source type and fill
in the required fields.

Picture 8. Adding a source by Add Entry Manually

You can also add documents to your library directly from the webpage you
have open in your browser. For example, if an IEEE database has an article to
use in its thesis, it is possible to import it into your Mendeley library with a single click. This feature is called One-Click Web Importer. You must first enable
it from the Tools / Install Web Importer menu.
Picture 9. Activating the Web Importer tool
1

This will open a tutorial explaining how Web Importer
works in different browsers - you should add it to your
browser's bookmarks, which are always visible, and call
when you need to import from an open web page. For example, the IEEE database has an open publication that
needs to be cited in its final thesis. The Save to Mendeley
button, which you need to press, appears in the browser
bookmarks bar.
Clicking Save to Mendeley opens a window showing bibliographic data for the publication. If all is correct, click Save
- and the publication will be automatically added to the
Mendeley library and referenced in your work. Imported
publications can be repaired or opened directly in the Mendeley app.
Picture 10. Saving bibliographical data from WEB browser

Mendeley provides the ability to automatically replenish your Mendeley library even
when a document is stored in a specific folder that the user wants to add to his or her library.
Picture 11. Adding sources from folder
For example, if a user searches for keywords in a RTU subscribed database and saves the found documents
as PDFs in a folder on his computer for later reading, Mendeley can set the function to automatically add
all PDFs stored in that folder to the Mendeley library so that you can refer to them later and quote them.
This feature is called Watched Folders. It can be accessed from Tools / Options / Watched Folders and it
should be noted in which folders the PDF documents saved should be added to the Mendeley library. Mendeley provides the ability to synchronize the Mendeley Desktop with the Mendeley Web, for example, if a
user wants to access his or her library online from anywhere by authentication to the Mendeley Web site.
You must enable the synchronization feature to use Sync. This can be done from All Documents / Edit Settings. You should check the Synchronize attached files check box. You can choose whether documents
in your entire library will be synchronized or just documents in a specific folder. You need to keep track of
your GB volume so that it does not exceed the amount provided free of charge.
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Creating the library
The Mandeley tool provides extensive document management
capabilities. You can mark documents as read or unread.
When documents are added to the Mendeley library, they are
marked as unread, so the user can keep track of what has been
added and what needs to be read. When a document opens in
the Mendeley PDF Viewer tab, the document is marked as
read.
Picture 12. Document’s status in the Mendeley
You can open the document in Mendeley PDF Viewer by double-clicking it. Mendeley PDF V iewer has a
visible toolbar that lets you add notes to text, highlight text, and more. etc. The PDF provides the ability to
search by entering key words. Mendeley provides the ability to organize library documents in various ways
in the File / Organizer Tools / Options / File Organizer. It is possible to copy all library documents into a
specific folder and create a folder structure by years, authors, journals, as well as rename each file attached
to the library according to the chosen principle, for example by author, year and title.
Mendeley provides the ability to clean the library of duplicates by selecting Tools / Check for Dublicates. It
is possible to merge duplicates by pressing the Confirm Merge button as long as the documents do not conflict with the bibliographic data.

Citing documents and list generating
Once a user has created their own library, Mendeley provides the ability to add references to Mendeley library documents in MS W ord and Open Office word processors, and create custom citations in accordance
with international standards. A list of references with citations used is generated automatically based on the
style you choose, significantly reducing the administrative burden for the researcher / student in finalizing
the research or thesis.
To use this feature, you need to enable the MS W ord or Open Office Mendeley
Plug-In. This can be done from the Tools / Install MS Word Plug In menu.

Picture 13. Adding and activating MS Word
When the plugin is enabled, a new Mendeley Cite-O-Matic
group will appear on the References tab of MS Word. First, in
this section, you need to select a citation style in the Style field
to be used for citations and the list of citations. If the desired
style is not immediately visible, you can press More Styles and
find the desired style.
Picture 14. Adding and activating MS Word
The style of the American Psychological Association 6th Edition (APA)
is the closest to the terms of this statute. Pressing the Insert Citation button opens the Mendeley window where you can find the document to be
quoted. Quotes can be searched for by any keyword: author, titles or part
thereof, year, magazine, etc. c. Among the found documents, select the
correct one, press the OK button - and the reference will appear in the text
according to the selected standard.
Picture 15. Example: Source Search list
After inserting all quotes, you can create a list of sources. The list will only be created from sources whose
citations have been used in the work. It will be created based on the previously selected referencing style.
To insert a list, you need to click Insert Bibliography. The inserted field will automatically update after inserting new citations in the document.
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4.6. References by MS Word
Starting with 2007-version, Microsoft Office W ord can automatically create a list of references and
sources, and make references. When you create a new source, all the source information is stored on your
computer so that you can find and reuse any created source in other studies.

New citation and source adding
Adding a new citation to a document also creates a new source that will appear in the list of references and
sources used.
1. In the References tab, in the Quotations & Bibliography group, click the arrow
next to Style. Click on the style you want to use for the quote and source. For example, citations and sources in social science papers typically use the MLA or
APA style.
Picture 16. Example: Creating style
2. Click at the end of the sentence or phrase you want to quote. On the References tab, in the Quotations
& Bibliography group, click Insert Citation. As a result, the text will look like this: (F rance, Vendele, 2016). In all references where possible, the page number used must be entered manually.

Adding new source
To add information about a new source, click Add New Source.

Picture 17. Example: Adding new source
Click on the arrow next to Type of Source to begin filling in the source information. For example, the source
may be a book, report, or website. Complete the source
bibliographic list information.
To add more source information, select the Show All
Bibliography Fields check box.

Picture 18. Example: Adding new source

Location of the source
The list of reviewed and cited sources can
be quite long. Occasionally, using the Management Source command, you must
search for a source quoted in another document. On the References tab, in the Quotations & Bibliography group, click Manage
Sources.

Picture 19. Example: Managing sources
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To find a specific source, do one of the following:


sort by author, title, citation title, or year in the Sort by ... box, and then search for a list of results for
the source you want;



In the Search box, type the name or author of the source you are looking for. The list narrows significantly to match the search term.

In the Source Manager dialog, you can click the Browse button to select another base list from which you
can import new sources into the document. For example, you can connect to a shared file, research colleague's computer, server, or website used by a university or research institution.

Manage Sources
You may want to create a citation for a placeholder and then complete the bibliographic source information
later. Any changes you make to the source are automatically reflected in the bibliography, if one has already been created. A question mark appears next to placeholder sources in the Source Manager.
On the References tab, in the Quotations & Bibliography group, click Manage Sources. In the Master List
section, click the placeholder you want to edit. Click Edit. Click on the arrow next to Type of Source to
begin filling in the source information. For example, the source may be a book, report, or website.
To add more source information, select the Show All Bibliography Fields check box.

Creating the list
A list of references and sources can be created at any time when one or more sources are included in the
document. If you do not have all the information you need to describe the source, you can use a placeholder
quote to complete the citation and complete the source information later. Click where you want the list of
literature and sources to be placed. Usually this list is at the end of the document. On the References tab, in
the Citations & Bibliography group, click Bibliography.

Picture 20. Example: Adding bibliographical list
Click a predefined bibliographic list format to insert a bibliographic list into your document.
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5. SUBMISSION OF THE THESIS
75.Before you print a Thesis, make sure that:


Table of contents, list of tables and figures contains correct and accurate titles, titles and page numbers;



All text and images are well legible when printed, including colour illustrations and photographs
(images are clear and have appropriate colours and fonts that can be distinguished);



All pages are numbered and in the correct order, and formatted according to guidelines

76.Print Thesis copies for submission with a laser printer or other high quality printer. Print two-sided (on
both sides) on A4 (210 × 297 mm) sheets of white paper (80 g / m2).
77.First, a copy of the completed work is handed over to the supervisor (s). After the supervisor has read
and approved the work, it is the responsibility of the author of the work to submit in due time the final
copies, which shall be signed by the author of the work and the scientific supervisor on the first page.
78.A summary of the thesis in Latvian and English shall be submitted together with the thesis. The summary is prepared on one page (max 250 words), Times New Roman style, font style – Regular, font size
– 12pt.
79.The paper shall be submitted to the thesis examination commission (hereinafter referred to as "the commission") in hardcover, softcover and electronic version (.pdf). The electronic version shall be submitted
on the day of defence. The number of copies submitted is as follows:


1 copy of hardcover;



1 copy in softcover;



1 electronic copy submitted on defense day (downloaded to specified computer).

80.The hardcover copy on the front cover should bear the heading BACHELOR THESIS or MASTER
THESIS (all in capital letters) in the center of the cover, in the lower part of the cover - the place and
year of the work, for example, RTU 2020.
81.It is recommended that an envelope is attached to the inner back cover of the Thesis submitted to RTU
to place a summary in two languages, review, and other Thesis related documentation. The envelope is
attached only to the Thesis copy in hard covers.
Summary is written as 2 pages per one:

Picture 21. Example: 2
pages per one for Summary submission
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82.The electronic version of the work must have all the same parts of the work as the printed copy. The
electronic version shall be submitted to the committee on the day the thesis is defended. Without
an electronic version, the Thesis cannot be defended!
83.Work submission into the RTU ORTUS system:
Not later than 5 days before the defense of the Thesis the student shall provide basic information about
the work in RTU internal system ORTUS by filling in the electronic form. Once the information has
been uploaded, the student prints a application generated automatically in the system. It shall be signed
and attached to the final thesis immediately after the declaration of authorship.
Before submitting the final thesis, ORTUS submits an application for the final thesis to the Dean's Office by December of each academic year. If the title of the thesis is changed before the defense, the application must be resubmitted as it will allow you to upload the thesis to ORTUS. The application form
can be obtained from the Dean's Office.
Once you submit your Thesis title application, you can upload the Thesis to ORTUS. This system adds
all work in a Portable Document Format (PDF) with the option disabled to copy text from a file. You
can convert your work by typing "encrypt pdf" into your web browser's Google site, then selecting a site
that suits you and converting the file. It is MANDATORY to have a "ticked" field “Graduate paper contains restricted information”.

Picture 22. Steps to upload work in Ortus
84. All printing and binding costs are covered by the student.
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6. PLAGIARISM AND ITS DETECTION
Plagiarism is the presentation of another person's work or idea as one's own without identifying the true
author. This can include information from websites, books, scientific articles, other articles, television
shows, emails, interviews, artwork, and more. Whenever you rephrase, summarize, or use any text from
another person's work, you must identify the source of the information in the work by reference. It is not
enough only with source indication bibliography at the end of work. Plagiarism is considered to be:


transferring another's work as one's own;



copying words or ideas from someone without reference;



not quoting quotation marks;



misrepresentation of citation source;



word change, retaining the source sentence structure without referring to the source;



copying so many words or ideas from a source that it does most of the work, whether the source is
listed or not.

Plagiarism is an academic dishonesty. Therefore, software is used to determine it. It will check all submissions. Submitting students are informed of the results of plagiarism by email or in person. The consequences of violation of scientific ethics and plagiarism are stipulated in the regulations of Riga Technical University as well as in the student contract.
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7. PRESENTING THE THESIS IN THE FINAL DEFENSE
The defense of the thesis takes place orally. It provides an opportunity to share work-based research with
the committee and colleagues.
There are five parts to the thesis defense:
1. slide-show presentation of the thesis,
2. questions by the thesis defense committee (and others present);
3. reviewer’s evaluation and questions,
4. supervisor’s evaluation;
5. short video presentation.

7.1. Guidelines for presentation slides
The presentation is prepared using Power Point or other slide creation software. The presentation should be
10 minutes long and should include:


Statement of the problem/topicality,;



Aim and objectives of the thesis;



Methodology applied;



Results and findings;



Conclusions and recommendations,



List of author’s publications and presentations.

Here are some basic tips for formatting slides:


Use text large enough to be readable by the audience (especially text from figures),



Include only key words or phrases on the slides,



Include diagrams, pictures, graphs, charts etc. rather than tables where appropriate,



Ensure all graphics and tables are clear,



Do not use the automatic slide overlay setting, we recommend that you slide the slides manually



Use spell check and proof-read.

7.2. Preparing for presentation


It is advisable to train the presentation material before the defense;



Improve diction if necessary,



Check that the time allowed for the presentation is not exceeded;



Before the presentation, make sure the audience computer and projector are working properly.

Suitable clothing for the defense is desirable, just as people tend to go to job interviews or speak at conferences.
On average, it takes 20 to 30 minutes to defend one student's work, so it's a good idea to bring a bottle of
water with you.
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7.3. Answering questions
At the end of the presentation, the defense committee and the audience have the opportunity to ask questions and engage in discussions about the work being defended. Answering the questions gives the student
the opportunity to expand on the information already provided and to demonstrate their understanding of
the topic. Here are some tips to help you answer your questions:


Listen to the entire question, no matter how long it takes a defense committee member or other student to ask (write down if necessary);



Think twice before answering;



If necessary, rephrase the question briefly;



Answer the question as best you can.

After the defense questions are asked and the reviewer gives his / her assessment.
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Riga Technical University
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TITLE
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Supervisor (Name Surname, degree 3)
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Appendix 2

Confirmation
______ 1 Thesis is developed at
the Institute of Energy Systems and Environment (IESE)

Author: Name, Last name

_________________
(signature, date)

Scientific supervisor:
Degree, name, last name

_________________
(signature, date)

Quality control: Name, Last name

_________________
(signature, date)

The thesis is suggested for defense at the IESE ______5 thesis examination commission:

Director of the FEEE IESE:
Dr.habil.sc.ing., professor D. Blumberga

________________
(signature, date)

______ 5 thesis is defended at the IESE ______ 5 thesis examination commission session on June___ ,
2020 and evaluated with mark ______________ .
Secretary of the _______ 5 Thesis
defense commission

_________________
(signature, date)
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Appendix 3

Declaration of authorship

I,
the
undersigning,
hereby
declare
that
the
______5
Thesis
entitled
………………………………………………………………………………………………………………
……………………………………………………………………………………………………………...7.
is, to the best of my knowledge and belief, original and the result of my own investigations, except as
acknowledged, and has not been submitted, either in part or whole, for a degree at this or any other University.
Formulations and ideas taken from other sources are cited as such. This work has not been published.

Name, Last name ……………………………. 2
Date: dd.mm.yyyy.
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